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Reporting from Lists in IROC

IROC provides dispatch managers with the ability to create reports specified to your needs. You can use the various filter
and search tools in IROC Data Management Tool (DMT) to find exactly what you need. You can then save your filters,
create favorites, share favorites, and export the material for reporting purposes.

Filtering Lists

Filtering lists is a powerful feature that allows you to quickly find and organize data as you need it. IROC DMT provides
several ways to use filters to create custom views of information. You can use one or all of these to find the information
for a report.

Breadcrumbs

As you apply filters to a list, breadcrumbs appear at the top of the page. Breadcrumbs are ordered from left to right—the
leftmost element is the most general, and the right is the most specific.

? All>Incident Name >=idaho>Incident Number =2019-CABDF-005008 > Incident Number !=2019-CABDF-005008

Clicking a breadcrumb element (such as =ldaho) keeps that condition but removes all the conditions to the right of it.

2 Clicking the condition separator (>) before a condition removes only that condition.
For example, in the breadcrumbs list shown here, clicking the arrow to the left of “=idaho” would delete only that
condition; everything to the right of it will remain.

I Note: Gray text in a breadcrumbs list cannot be changed.

Right-Click Filtering

Use this tool in any module that provides a list view in the main content area, such as All Incidents. Simply right-click on a
field and choose either Show Matching or Filter Out.

CO-PFAX-IMHS551  Fire - Widies na.n.9019 15:23:51 Mountain
Show Matching
CO-PFAX-559231220 Fn  FiterOut 19 15:48:32 Mountain

Copy URL to Clipboard

CO-PFAX-IMHTest2 Fir Assign Tag > 1915:49:17 Mountain

¢ Show Matching — Shows all records that match that term.
¢ Filter Out — Excludes all records that match that term.

I Tip: To revert to the previous view of the list, use the breadcrumbs, or click the Delete icon (%) beside the applied filter
and click Run.
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Grouping

You can filter a list by grouping related elements. There are two options for grouping by a column.

1 Option 1: Right-click on the column heading you want to group records by and select the Group By... option from the
drop-down menu.

? All = Resource Active = true
b Q = Resource Operational Name v = Respuras Mams. = Barauen Siatlls
Sort (atoz)
Search Seard  Sort(ztoa)
" « Abiqui
® + Abiquiu Volunteer Fire Department FireDep  Group By Resource Name
Tanker 1
Tank...
Barchart
v
-Abiqui  p;,
. Abiquiu Volunteer Fire Department 0 Ple Chart
@® Fire Def
Brush Truck

Brus... Export >

2 Option 2: Click the List Controls icon at the top left of the main content frame to select an overall category for
grouping items. Hover over Group By... to open a drop-down menu of options. Click on your preferred option.

= | PETI-Racnurea Sratys with Quals  Search | Resource Operational Naméeyw
Filters by |
‘? Group By > — None -
& Show > pvailable Area =
Refresh List Class | =
Create Favorite Current Assignment 5
Current Assignment Sys ID ;

+AbiqUi  Cyyrrent Dis 4 Rk

- patch

Al P — = = Ass|
Current Dispatch GACC

Currant Dicnatrh CACC Mama

I Note: The Group By... option is not available for all columns.

3 You then have two options for viewing all records in a grouped list:

a Option 1: Click on the arrow to the left of the heading to expand or collapse the list of records.

? All = Incident Dispatch GACC Name Is not empty
5] Q, = Incident Dispatch GACC = Incident Dispatch E
Search Search
- '@cc; Alaska Interagency Coordination Center {19757)
- Alaska Interagency Delta Area Forestry
{D Coordination Center Dispatch ]
— Alaska Interagency Delta Area Forestrv 2

b Option 2: Click on the hyperlink to open a separate window that shows only the list of related records.

? All=Incident Dispatch GACC Name is not empty
P oo Q, = Incident Dispatch GACC = Incident Dispatch =|
Search Search 4

» GACC: Australasian Fire and Emergency Service Authorities Council {385)

» GACC: Eastern Area Coordination Center {4491)

» GACC: Great Basin Coordination Center (24948)
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Complex Filters

Another option for filtering lists is to use the powerful Search and Filter tools.

=  Incidents Search IncidentName ¥ | Search
S Al

Run Save... AND OR || AddSort @ %z

All of these conditions must be met

-- choose field -- v -- oper - --value -

-- choose field -- v -- oper - -- value - X

OR all of these conditions must be met

-- choose field -- v -- oper -- --value - X

Order results by the following fields

Dispatching Organization v atoz j X

1 Click the Filter icon (Y) to show (or hide) the filter modification options.

2 Click AND or OR to add conditions to the filter.
a Choose an option and an operator from the Choose Field and Operator drop-down menus, respectively.
b Type text in each Search (-value-) field.

nu

Note: The content in the Choose Field drop-down varies depending on the list. The content in the Operator drop-down
varies depending on the selected field. Examples of operators are “is,” “starts with,” “ends with,” and so forth.

3 Click Add Sort to add a column sort function to the filter (e.g., sort a column in ascending or descending order after
the filter has been applied).

a Choose a list column from the first drop-down.
b Indicate in the second drop-down whether to sort in ascending or descending order.
I Note: The screenshot shows fields for both the AND and the OR conditions, as well as for the Add Sort function.
4 Toremove a condition, click Delete (%) to the right of the field.

5 After all information is entered, click Run to apply the filter to the list.
The filters you have applied will appear in the breadcrumbs.

Saving Filters

After applying filters, you can Save them to use again in the future.
1 Enter a name for your filter and click Save.

? All = Activity = Active > Incident Type = Fire - Wildfire

Run || AND OR | AddSort || %4

Save as:

=

visible to: @ Me | save

All of these conditions must be met

Activity v is v

2 To access this filter again from this list, click the List Controls (=) icon and choose it from the Filters drop-down.
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Sharing Filters

You can also share a filter with a coworker.

1 After applying filters, highlight the URL in your web browser.
2 Right-click and select Copy from the options or press Ctrl-C.

3 Paste the URL in an email or other message and send to your coworker.
Your coworker must also have access to IROC DMT.

Creating Favorites in the Data Management Tool
After applying a filter, you may want to save it as a favorite for easy access in the future. Favorites are stored at the top of
your All Files menu in the Application Navigator and in the Favorites menu.
I Tip: Creating favorites is a good way to filter out applications or modules that you do not often use.
1 There are several ways to create a favorite after applying a filter.

a Click the List Controls icon (=) and select Create Favorite. In the screen that appears, name the list and apply a
color an icon. Then click Done.

=  Incidents SearcH

Filters > F
g

Group By >0

Show >0
R |0

Refresh List -

I Create Favorite

b Hover over the name of an application or module in the File tab of the application navigator. Click the Star to add
this to your favorites.

Add To Favorites

Airport Special Conditions

Aviation Hazards

¢ Drag the last item in a breadcrumbs list to the Favorites menu in the Application Navigator.

2 You can customize your Favorites by clicking the Pencil (¢*) icon in the lower right corner of the Favorites menu.
Rename your favorite and choose a color and icon to be associated with it.

3 Toremove a filter, hover to the right of the name in the Favorites menu and click the Remove From Favorites icon.

©

Remave from favorites

) Home

Incidents
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Performing Searches

In addition to applying filters, you can also use the Search tools in DMT to find information for reports.
1 List search filter — This tool is found at the top of the main content area.

Search | Incident Name ¥ | Search

a Choose a data element (column) from the filter drop-down (e.g., “Incident Name”).
b Type your search term in the search field.

¢ Press Enter.
The main content area will show all records that match your search criteria.

2 Column header search -

Q, = Created = Code = Incident Name A = Incident Number

Search Search Search Search

a Click the Search icon (Q) to show/hide the search fields at the top of each column. (Click this icon again to hide
the search fields.)

b Type text in one or more fields.
You can press Tab on your keyboard to move from field to field.

d When done, press Enter.
I Tip: To remove a search term, delete it from the Search field and press Enter again.

Wildcard Searches

All search fields support wildcard searches. Use the symbols as shown in the left column to perform the search described
in the right column.

Wildcard Entry Description

*search-term

Values that contain search term
%search-term%

%search-term Values that end with search term
search term% Values that start with search term
=search term Values that equal search term

I*search term Values that do not contain search term

I=search term Values that do not equal search term
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Personalizing Lists in the Data Management Tool
IROC DMT offers you a way to personalize the information you see in each list—for example, by adding or removing
columns or changing their order of appearance on the screen.

Tip: When selecting items in either the Available or Selected field, you can select more than one item by using Ctrl-
Click or Shift-Click. You can also click and drag to select a number of sequential items.

1 Click the Personalize List (£) icon in the top-left corner of a list view to open the Personalize List Columns screen.

Personalize List Columns p 4
Available Selected
Activation Date Updated
Agency Code Catalog
Attributes System of Record
Available Area Class
Category Name
Created Created by
Created By System > Resource Status ~
Current Assignment Dispatch Organization
Days Currently Committed < Current Dispatch Organization G
Days Currently Committed (Excl Home Unit Organization
Deactivation Date Provider Organization.Organiza:
Dispatch Org Code IrwinRID
Dispatch Status Is Valid
Display Name Active
Documentation (Remarks) ROSSID
Employment Class o
+| Wrap column text Compact rows Active row highlighting %
+| Modern cell coloring
+| Enablelistedit |+| Doubleclickto edit
Reset to column defaults Cancel n

2 To add an item(s) to your list view, select it in the Available field and then click the right-pointing arrow.
3 Toremove an item(s) from your list view, select it in the Selected field and then click the left-pointing arrow.
4 To change the order of columns, click an item in the Selected field and use the up or down arrows to move it.

I Tip: To move more than one item, click and drag to highlight and then use the up/down arrows to move them as a
group.

5 Click the checkboxes at the bottom of the screen to change list view and action options.

6 When done, click OK.

Exporting Lists in the Data Management Tool

Once you have configured your list to show all relevant information, you can save the list or export it for reporting.

1 Right-click on any column header. = nrident Tuna = Inrident Created On =~ =

2  Select an option from the Export drop-down (MS o o] ' Ny
Excel, CSV, JSON, or portrait of landscape PDF). Sort(ztoa)

3 When the export is complete, choose Download to Fire - L7:55:46 Pad

X . Group By Incident Type
save or open the file on your device.

Fire- BarChart 22:13:49 Moy
Pie Chart
Fire-  Export A > Excel (.xlsx) u
csv
Fire - Wildfire 03-05-2019.  JsoN |

PDF >




	Breadcrumbs
	Right-Click Filtering
	Grouping
	Complex Filters
	Saving Filters
	Sharing Filters
	Wildcard Searches


<<

  /ASCII85EncodePages false

  /AllowTransparency false

  /AutoPositionEPSFiles true

  /AutoRotatePages /None

  /Binding /Left

  /CalGrayProfile (Dot Gain 20%)

  /CalRGBProfile (sRGB IEC61966-2.1)

  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)

  /sRGBProfile (sRGB IEC61966-2.1)

  /CannotEmbedFontPolicy /Error

  /CompatibilityLevel 1.4

  /CompressObjects /Tags

  /CompressPages true

  /ConvertImagesToIndexed true

  /PassThroughJPEGImages true

  /CreateJobTicket false

  /DefaultRenderingIntent /Default

  /DetectBlends true

  /DetectCurves 0.0000

  /ColorConversionStrategy /CMYK

  /DoThumbnails false

  /EmbedAllFonts true

  /EmbedOpenType false

  /ParseICCProfilesInComments true

  /EmbedJobOptions true

  /DSCReportingLevel 0

  /EmitDSCWarnings false

  /EndPage -1

  /ImageMemory 1048576

  /LockDistillerParams false

  /MaxSubsetPct 100

  /Optimize false

  /OPM 1

  /ParseDSCComments true

  /ParseDSCCommentsForDocInfo true

  /PreserveCopyPage true

  /PreserveDICMYKValues true

  /PreserveEPSInfo true

  /PreserveFlatness true

  /PreserveHalftoneInfo false

  /PreserveOPIComments true

  /PreserveOverprintSettings true

  /StartPage 1

  /SubsetFonts true

  /TransferFunctionInfo /Apply

  /UCRandBGInfo /Preserve

  /UsePrologue false

  /ColorSettingsFile ()

  /AlwaysEmbed [ true

  ]

  /NeverEmbed [ true

  ]

  /AntiAliasColorImages false

  /CropColorImages true

  /ColorImageMinResolution 300

  /ColorImageMinResolutionPolicy /OK

  /DownsampleColorImages true

  /ColorImageDownsampleType /Bicubic

  /ColorImageResolution 300

  /ColorImageDepth -1

  /ColorImageMinDownsampleDepth 1

  /ColorImageDownsampleThreshold 1.50000

  /EncodeColorImages true

  /ColorImageFilter /DCTEncode

  /AutoFilterColorImages true

  /ColorImageAutoFilterStrategy /JPEG

  /ColorACSImageDict <<

    /QFactor 0.15

    /HSamples [1 1 1 1] /VSamples [1 1 1 1]

  >>

  /ColorImageDict <<

    /QFactor 0.15

    /HSamples [1 1 1 1] /VSamples [1 1 1 1]

  >>

  /JPEG2000ColorACSImageDict <<

    /TileWidth 256

    /TileHeight 256

    /Quality 30

  >>

  /JPEG2000ColorImageDict <<

    /TileWidth 256

    /TileHeight 256

    /Quality 30

  >>

  /AntiAliasGrayImages false

  /CropGrayImages true

  /GrayImageMinResolution 300

  /GrayImageMinResolutionPolicy /OK

  /DownsampleGrayImages true

  /GrayImageDownsampleType /Bicubic

  /GrayImageResolution 300

  /GrayImageDepth -1

  /GrayImageMinDownsampleDepth 2

  /GrayImageDownsampleThreshold 1.50000

  /EncodeGrayImages true

  /GrayImageFilter /DCTEncode

  /AutoFilterGrayImages true

  /GrayImageAutoFilterStrategy /JPEG

  /GrayACSImageDict <<

    /QFactor 0.15

    /HSamples [1 1 1 1] /VSamples [1 1 1 1]

  >>

  /GrayImageDict <<

    /QFactor 0.15

    /HSamples [1 1 1 1] /VSamples [1 1 1 1]

  >>

  /JPEG2000GrayACSImageDict <<

    /TileWidth 256

    /TileHeight 256

    /Quality 30

  >>

  /JPEG2000GrayImageDict <<

    /TileWidth 256

    /TileHeight 256

    /Quality 30

  >>

  /AntiAliasMonoImages false

  /CropMonoImages true

  /MonoImageMinResolution 1200

  /MonoImageMinResolutionPolicy /OK

  /DownsampleMonoImages true

  /MonoImageDownsampleType /Bicubic

  /MonoImageResolution 1200

  /MonoImageDepth -1

  /MonoImageDownsampleThreshold 1.50000

  /EncodeMonoImages true

  /MonoImageFilter /CCITTFaxEncode

  /MonoImageDict <<

    /K -1

  >>

  /AllowPSXObjects false

  /CheckCompliance [

    /None

  ]

  /PDFX1aCheck false

  /PDFX3Check false

  /PDFXCompliantPDFOnly false

  /PDFXNoTrimBoxError true

  /PDFXTrimBoxToMediaBoxOffset [

    0.00000

    0.00000

    0.00000

    0.00000

  ]

  /PDFXSetBleedBoxToMediaBox true

  /PDFXBleedBoxToTrimBoxOffset [

    0.00000

    0.00000

    0.00000

    0.00000

  ]

  /PDFXOutputIntentProfile ()

  /PDFXOutputConditionIdentifier ()

  /PDFXOutputCondition ()

  /PDFXRegistryName ()

  /PDFXTrapped /False



  /CreateJDFFile false

  /Description <<



    /BGR <>

    /CHS <FEFF4f7f75288fd94e9b8bbe5b9a521b5efa7684002000410064006f006200650020005000440046002065876863900275284e8e9ad88d2891cf76845370524d53705237300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c676562535f00521b5efa768400200050004400460020658768633002>

    /CHT <FEFF4f7f752890194e9b8a2d7f6e5efa7acb7684002000410064006f006200650020005000440046002065874ef69069752865bc9ad854c18cea76845370524d5370523786557406300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c4f86958b555f5df25efa7acb76840020005000440046002065874ef63002>

    /CZE <>

    /DAN <>

    /DEU <>

    /ESP <>

    /ETI <>

    /FRA <>

    /GRE <>



    /HRV (Za stvaranje Adobe PDF dokumenata najpogodnijih za visokokvalitetni ispis prije tiskanja koristite ove postavke.  Stvoreni PDF dokumenti mogu se otvoriti Acrobat i Adobe Reader 5.0 i kasnijim verzijama.)

    /HUN <>

    /ITA <>

    /JPN <FEFF9ad854c18cea306a30d730ea30d730ec30b951fa529b7528002000410064006f0062006500200050004400460020658766f8306e4f5c6210306b4f7f75283057307e305930023053306e8a2d5b9a30674f5c62103055308c305f0020005000440046002030d530a130a430eb306f3001004100630072006f0062006100740020304a30883073002000410064006f00620065002000520065006100640065007200200035002e003000204ee5964d3067958b304f30533068304c3067304d307e305930023053306e8a2d5b9a306b306f30d530a930f330c8306e57cb30818fbc307f304c5fc59808306730593002>

    /KOR <FEFFc7740020c124c815c7440020c0acc6a9d558c5ec0020ace0d488c9c80020c2dcd5d80020c778c1c4c5d00020ac00c7a50020c801d569d55c002000410064006f0062006500200050004400460020bb38c11cb97c0020c791c131d569b2c8b2e4002e0020c774b807ac8c0020c791c131b41c00200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000410064006f00620065002000520065006100640065007200200035002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e>

    /LTH <>

    /LVI <>

    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken die zijn geoptimaliseerd voor prepress-afdrukken van hoge kwaliteit. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 5.0 en hoger.)

    /NOR <>

    /POL <>

    /PTB <>

    /RUM <>

    /RUS <>

    /SKY <>

    /SLV <>

    /SUO <>

    /SVE <>

    /TUR <>

    /UKR <>

    /ENU (Use these settings to create Adobe PDF documents best suited for high-quality prepress printing.  Created PDF documents can be opened with Acrobat and Adobe Reader 5.0 and later.)

  >>

  /Namespace [

    (Adobe)

    (Common)

    (1.0)

  ]

  /OtherNamespaces [

    <<

      /AsReaderSpreads false

      /CropImagesToFrames true

      /ErrorControl /WarnAndContinue

      /FlattenerIgnoreSpreadOverrides false

      /IncludeGuidesGrids false

      /IncludeNonPrinting false

      /IncludeSlug false

      /Namespace [

        (Adobe)

        (InDesign)

        (4.0)

      ]

      /OmitPlacedBitmaps false

      /OmitPlacedEPS false

      /OmitPlacedPDF false

      /SimulateOverprint /Legacy

    >>

    <<

      /AddBleedMarks false

      /AddColorBars false

      /AddCropMarks false

      /AddPageInfo false

      /AddRegMarks false

      /ConvertColors /ConvertToCMYK

      /DestinationProfileName ()

      /DestinationProfileSelector /DocumentCMYK

      /Downsample16BitImages true

      /FlattenerPreset <<

        /PresetSelector /MediumResolution

      >>

      /FormElements false

      /GenerateStructure false

      /IncludeBookmarks false

      /IncludeHyperlinks false

      /IncludeInteractive false

      /IncludeLayers false

      /IncludeProfiles false

      /MultimediaHandling /UseObjectSettings

      /Namespace [

        (Adobe)

        (CreativeSuite)

        (2.0)

      ]

      /PDFXOutputIntentProfileSelector /DocumentCMYK

      /PreserveEditing true

      /UntaggedCMYKHandling /LeaveUntagged

      /UntaggedRGBHandling /UseDocumentProfile

      /UseDocumentBleed false

    >>

  ]

>> setdistillerparams

<<

  /HWResolution [2400 2400]

  /PageSize [612.000 792.000]

>> setpagedevice



